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| - DOWNLOAD

1. Log in to your Codecanyon account, choose "Download" from the menu
Or head to https://codecanyon.net/downloads

Hi. Themelego!

Allltems  PHP Scripts ~ WordPress  eCommerce  JavaScript  CSS  Mobile HTML5 Skins WP Themes  Plugins  More

Home Files WordFress Add-ons I I

VCKit - WPBakery Page Builder addons collection (Visual Co

Downloads I
i

Item Details Reviews Comments Support Edit History Analytics

2. Click "Download" button on item you want to download

Dashboard Profile  Portfolio Followers Falln'-;«inga Seftings  Hidden ltems Downloads  Reviews Refunds Withdraw,

All marketplaces v | Sortby: | Date Purchased v T

VCKit - WPBakery Page R
Builder addons collection
(Visual Composer) Al files & documentation @ up with

1or $at

: stallable WordPress fil
Regular License Installab ordP! file only

4 months of support remaining. Extend now License cerfificate & purchase code (FDF)

| Get notified by email if this item is updated License cerificate & purchase code (text)
3. Extract the zip file to your computer.

4. Done


https://codecanyon.net/downloads

Il - INSTALLATION

1. Install WPBakery Page Builder

WPBakery Page Builder is a page builder for wordpress. To use this plugin
please install WPBakery Page Builder first: Codecanyon WPBakery Page
Builder

WPBAKERY PAGE BUILDER FOR WDRDPRESS

(FORMERLY VISUAL COMPOSE

YOUR TOP CHOICE FOR

ANY WORDPRESS SITE & THEME

BUILD ANY LAYOUT TODAY

Bloomberg JiSLIS

2. Install & active VCKit plugin

Login to your Wordpress admin dashboard >> Plugin >> Add new then:
e Click "Upload" plugin

Add Plugins | uplead plugin

Featured Popular Recommended  Favorites

Plugins extend and expand the functionality of WordPress. You may install plugins from the Plugin Directory or upload a plugin in zip format by clicking the button at the

+ . Jetpack by WordPress.co! m tall N
Increase your traffic, view your stats, to test your them 2 D
. speed up your site, and protect yoursel dPress standards
from hackers with Jetpack. t them
By Automattic



https://codecanyon.net/item/visual-composer-page-builder-for-wordpress/242431?s_rank=1
https://codecanyon.net/item/visual-composer-page-builder-for-wordpress/242431?s_rank=1

e Click "Choose file"
Then inside the package Visual Composer Kit you downloaded from
Codecanyon, choose file visual-composer-kit.zip.

If you have a plugin in a .zip format, you may install it by uploading it here,

| Choose File | No file chosen

Note: you need to extract the zip file downloaded from Codecanyon to find the
right file to upload.

e Click "Install now"

e Activate plugin

Installing Plugin from uploaded file: visual-composer-kit.zip
Unpacking the package...

Installing the plugin. ..

Pluglninstalled successfully.

Activate Plugin f Return to Plugin Installer

Done.



lll - CONFIGURATION YOUR WEBSITE

1. Create a new page with WPBakery Page Builder plugin
Edit with Backend Editor (or Frontend editor) > Add Element

fest Publis] ry

Posts

Permalink: http://test.themelego.com/test/ Preview Changes

1 Media

®  Classic M Frontend Editor 9 status: Published Edit

|! Pages

@ Visibility: Public Edit
All Pages

WPBakery Page Builder * ) Revisions: 147 Browse

fifl] Published an: May 26, 2017 @ 03:02
Comments 2

Move to Trash Update

¢ Plugins (3 Page Attributes a

Contact

Appearance

Users
Parent

Tooks YOU HAVE BLANK PAGE (hoparen) v
e START ADDING CONTENT OR TEMPLATES order

Builder
0
. Need help? Use the Help tab above the
MailChimp for WP Add Element = Add Text Blo Add Template screen title.
1 Quick View
ur knowledge base.
i e Featured Image a

ial Composer Addons WordPress Plugin 8 B 14 == New ViewPage Howdy, admin

Dashboard
s Add Element

Al Content Sodal Strucure  WordPress Widgets [QEEGGGHENE Deprecated
Testimonials

Media E Animation Block

Contact Form 7

Card Flip
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Drop Caps a Google Map

Comments 4 G@gle Grid

. Interactive Grid
Contact

@ Heading Effects D
Icon Box Image Banner
Appear; E and content . simple, creati @ Image Slider .

Image Tilt
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Details about each addon are below:

List of VCKit’s Elements

No. Logo Element Description Demo Link
1 Button Button with styles & mouse http://vckit.themelego.com/shor
Inspiration hover effect tcodes/buttons/
2 Interactive Creative and subtle mouse http://vckit.themelego.com/shor
Hover hover effect tcodes/interactive-hover/
http://vckit.themelego.com/shor
tcodes/interactive-hover-set-2/
3 Interactive Navigator bar with hover http://vckit.themelego.com/inter
Navigator effect active-navigation/
4 One Page Navigator bar in one page http://vckit.themelego.com/shor
Navigator tcodes/one-page-navigator/
5 Interactive Pop-up notification http://vckit.themelego.com/shor
@ Notification tcodes/interactive-notification/
6 Tilt Hover Mouse hover effect with slight | http://vckit.themelego.com/shor
tilt effect tcodes/tilt-hover/
7 Image Tilt Display of images with slight | http://vckit.themelego.com/shor
I Effect tilt hover effect tcodes/image-tilt-effect/



http://vckit.themelego.com/shortcodes/buttons/
http://vckit.themelego.com/shortcodes/buttons/
http://vckit.themelego.com/shortcodes/interactive-hover/
http://vckit.themelego.com/shortcodes/interactive-hover/
http://vckit.themelego.com/shortcodes/interactive-hover-set-2/
http://vckit.themelego.com/shortcodes/interactive-hover-set-2/
http://vckit.themelego.com/interactive-navigation/
http://vckit.themelego.com/interactive-navigation/
http://vckit.themelego.com/shortcodes/one-page-navigator/
http://vckit.themelego.com/shortcodes/one-page-navigator/
http://vckit.themelego.com/shortcodes/interactive-notification/
http://vckit.themelego.com/shortcodes/interactive-notification/
http://vckit.themelego.com/shortcodes/tilt-hover/
http://vckit.themelego.com/shortcodes/tilt-hover/
http://vckit.themelego.com/shortcodes/image-tilt-effect/
http://vckit.themelego.com/shortcodes/image-tilt-effect/

vertical flow.

8 Image Swap Display of images with http://vckit.themelego.com/shor
r swapping hover effect tcodes/image-swap/
9 Icon Display information in circle of | http://vckit.themelego.com/shor
Showcase icons, hover on each icon to tcodes/icon-showcase
change content
10 g Workflow Display content and image in | http://vckit.themelego.com/shor

tcodes/workflow

styles

11 Message Display of message in a box | http://vckit.themelego.com/shor
E Boxes tcodes/message-boxes/
12 Drop Caps Display of first letter with http://vckit.themelego.com/shor
different styles tcodes/drop-caps/
13 Card Flip Display of content box in http://vckit.themelego.com/shor
A flipping effect tcodes/card-flip/
http://vckit.themelego.com/shor
tcodes/card-flip-3d/
14 Separator Separator with different http://vckit.themelego.com/shor
styles, icons and effects tcodes/separator/
http://vckit.themelego.com/shor
tcodes/icon-separator/
15 List Display of content in list http://vckit.themelego.com/shor
styles, with icons tcodes/list/
16 ﬂ Google Map Display of google map with | http://vckit.themelego.com/shor

tcodes/google-maps/



http://vckit.themelego.com/shortcodes/image-swap/
http://vckit.themelego.com/shortcodes/image-swap/
http://vckit.themelego.com/shortcodes/icon-showcase
http://vckit.themelego.com/shortcodes/icon-showcase
http://vckit.themelego.com/shortcodes/workflow
http://vckit.themelego.com/shortcodes/workflow
http://vckit.themelego.com/shortcodes/message-boxes/
http://vckit.themelego.com/shortcodes/message-boxes/
http://vckit.themelego.com/shortcodes/drop-caps/
http://vckit.themelego.com/shortcodes/drop-caps/
http://vckit.themelego.com/shortcodes/card-flip/
http://vckit.themelego.com/shortcodes/card-flip/
http://vckit.themelego.com/shortcodes/card-flip-3d/
http://vckit.themelego.com/shortcodes/card-flip-3d/
http://vckit.themelego.com/shortcodes/separator/
http://vckit.themelego.com/shortcodes/separator/
http://vckit.themelego.com/shortcodes/icon-separator/
http://vckit.themelego.com/shortcodes/icon-separator/
http://vckit.themelego.com/shortcodes/list/
http://vckit.themelego.com/shortcodes/list/
http://vckit.themelego.com/shortcodes/google-maps/
http://vckit.themelego.com/shortcodes/google-maps/

17

Gradient
Background

Create gradient color
background easily

http://vckit.themelego.com/shor

tcodes/gradient-background

18

Mailchimp
Newsletter

Display of sign-up form for
newsletter with styles

http://vckit.themelego.com/shor

tcodes/mailchimp-newsletter/

19

Image Banner

Display of image banner with
styles

http://vckit.themelego.com/shor

tcodes/image-banner/

22

BaeE

Contact Form

20 Image Slider Display images in one slider | http://vckit.themelego.com/shor
tcodes/image-slider/
21 InstaFeed New Instagram element, http://vckit.themelego.com/shor

paste your token keys to show
your Instagram photos

The shortcode which includes

tcodes/instagram-feed/

http://vckit.themelego.com/shor

pulse, fade,...) for your
elements

7 the most popular contact tcodes/contact-form-7/
form plugin. You have to
import our contact form data.
Don't forget import our form.
23 Pricing Box The modern, responsive http://vckit.themelego.com/shor
pricing table for wordpress tcodes/pricing-box/
24 Before After The before and after image http://vckit.themelego.com/shor
<_||_) Image showcase tcodes/before-after-image/
25 Animation Just-add-whatever CSS http://vckit.themelego.com/shor
Block animations (bounce, flash, tcodes/animation-block/



http://vckit.themelego.com/shortcodes/gradient-background
http://vckit.themelego.com/shortcodes/gradient-background
http://vckit.themelego.com/shortcodes/mailchimp-newsletter/
http://vckit.themelego.com/shortcodes/mailchimp-newsletter/
http://vckit.themelego.com/shortcodes/image-banner/
http://vckit.themelego.com/shortcodes/image-banner/
http://vckit.themelego.com/shortcodes/image-slider/
http://vckit.themelego.com/shortcodes/image-slider/
http://vckit.themelego.com/shortcodes/instagram-feed/
http://vckit.themelego.com/shortcodes/instagram-feed/
http://vckit.themelego.com/shortcodes/contact-form-7/
http://vckit.themelego.com/shortcodes/contact-form-7/
http://vckit.themelego.com/shortcodes/pricing-box/
http://vckit.themelego.com/shortcodes/pricing-box/
http://vckit.themelego.com/shortcodes/before-after-image/
http://vckit.themelego.com/shortcodes/before-after-image/
http://vckit.themelego.com/shortcodes/animation-block/
http://vckit.themelego.com/shortcodes/animation-block/

26

Animated
Typing

Enter any string and watch it
type at the speed you've set,
backspace what it's typed,
and begin a new sentence for
however many strings you

http://vckit.themelego.com/shor

tcodes/animated-typing/

want to set.
27 Old Instagram Show the latest instagram http://vckit.themelego.com/shor
Feed photos from anyone. Just tcodes/instagram-feed/
paste the Instagram
username and it will show
that user’s Instagram feed.
There are 4 color schemes
that can be used.
28 QR Code Fast QR Code generator. http://vckit.themelego.com/shor
tcodes/qr-code/
29 Scroller Show an image in a fixed http://vckit.themelego.com/shor
Image height and scroll to the end tcodes/scroller-image/
when hovering.
30 Social Share | Custom social share buttons | http://vckit.themelego.com/shor
with impressive hover styles tcodes/social-share/
31 Carousel Display information in slider | http://vckit.themelego.com/shor
Slider format. tcodes/carousel-slider/
You can put any element into
a carousel item and
customize the style of
carousel slider.
32 Lightbox Put any element into a http://vckit.themelego.com/shor

lightbox.
Customize the popup/modal
with different sizes. Using
VCKit's button to open
lightbox or using extra class
to open lightbox by any
element.

tcodes/lightbox/



http://vckit.themelego.com/shortcodes/animated-typing/
http://vckit.themelego.com/shortcodes/animated-typing/
http://vckit.themelego.com/shortcodes/instagram-feed/
http://vckit.themelego.com/shortcodes/instagram-feed/
http://vckit.themelego.com/shortcodes/qr-code/
http://vckit.themelego.com/shortcodes/qr-code/
http://vckit.themelego.com/shortcodes/scroller-image/
http://vckit.themelego.com/shortcodes/scroller-image/
http://vckit.themelego.com/shortcodes/social-share/
http://vckit.themelego.com/shortcodes/social-share/
http://vckit.themelego.com/shortcodes/carousel-slider/
http://vckit.themelego.com/shortcodes/carousel-slider/
http://vckit.themelego.com/shortcodes/lightbox/
http://vckit.themelego.com/shortcodes/lightbox/

33 Team Display of team member http://vckit.themelego.com/shor
qu. Member information with styles tcodes/team-member/
R
34 Icon Box Icon with styles, effects http://vckit.themelego.com/shor
E: tcodes/icon-box/
35 Testimonial Testimonials is a clean and http://vckit.themelego.com/shor
easy-to-use testimonial style tcodes/testimonial/
to show on your site.
(work with Testimonials by
WooThemes)
36 Count Up Display your statistical data in | http://vckit.themelego.com/shor
@ count-up format, with icons tcodes/count-up/
37 Countdown The countdown element to http://vckit.themelego.com/shor
@ count down specific day. tcodes/countdown/
38 . Counter The easy pie chart element | http://vckit.themelego.com/shor
‘ ) Circle tcodes/circle-counter/
39 Video Modal The lightbox video to show http://vckit.themelego.com/shor
your youtube, vimeo video. tcodes/video-modal/
40 Progress Bar Display your progress as http://vckit.themelego.com/prog
horizontal or vertical bars with ress-bar/
different colors & styles and
deep customizability.
41 Heading Custom your title and heading | http://vckit.themelego.com/shor
Ezﬂdl] Effects text with some impressive tcodes/heading-effect/
effects



http://vckit.themelego.com/shortcodes/team-member/
http://vckit.themelego.com/shortcodes/team-member/
http://vckit.themelego.com/shortcodes/icon-box/
http://vckit.themelego.com/shortcodes/icon-box/
http://vckit.themelego.com/shortcodes/testimonial/
http://vckit.themelego.com/shortcodes/testimonial/
http://vckit.themelego.com/shortcodes/count-up/
http://vckit.themelego.com/shortcodes/count-up/
http://vckit.themelego.com/shortcodes/countdown/
http://vckit.themelego.com/shortcodes/countdown/
http://vckit.themelego.com/shortcodes/circle-counter/
http://vckit.themelego.com/shortcodes/circle-counter/
http://vckit.themelego.com/shortcodes/video-modal/
http://vckit.themelego.com/shortcodes/video-modal/
http://vckit.themelego.com/progress-bar/
http://vckit.themelego.com/progress-bar/
http://vckit.themelego.com/shortcodes/heading-effect/
http://vckit.themelego.com/shortcodes/heading-effect/

42 Heading Transform your title and http://vckit.themelego.com/shor
Gradient heading text color with tcodes/heading-gradient/
gradient effect
43 Samsung Grid | Display your grid with special | http://vckit.themelego.com/grids
gé) 3 appearance effects /samsung-grid/
44 Elegant Grid Display your content in http://vckit.themelego.com/grids
custom grid layouts with 8 /elegant-grid/
appearance effects
45 Interactive Display your content in http://vckit.themelego.com/grids
Grid custom grid layouts with 30 /interactive-grid/
subtle mouse hover effects
46 Magazine Displays your various in http://vckit.themelego.com/grids
Grid pop-up post and various /magazine-grid/
options
47 Google Grid Display your content grid in | http://vckit.themelego.com/grids
gé) Google Search style /google-grid/

4. Save changes and Publish! All done!



http://vckit.themelego.com/shortcodes/heading-gradient/
http://vckit.themelego.com/shortcodes/heading-gradient/
http://vckit.themelego.com/grids/samsung-grid/
http://vckit.themelego.com/grids/samsung-grid/
http://vckit.themelego.com/grids/elegant-grid/
http://vckit.themelego.com/grids/elegant-grid/
http://vckit.themelego.com/grids/interactive-grid/
http://vckit.themelego.com/grids/interactive-grid/
http://vckit.themelego.com/grids/magazine-grid/
http://vckit.themelego.com/grids/magazine-grid/
http://vckit.themelego.com/grids/google-grid/
http://vckit.themelego.com/grids/google-grid/

Detail Instruction

1. Interactive Hover

This element is actually Marvelous Hover Effects, so you can read its documentation or watch
tutorial video for more instruction.

2. Mailchimp Newsletter

e Installing plugin
In your WordPress admin panel, go to Plugins > Add New, search for MailChimp for WordPress
and click “Install now".
Alternatively, download the plugin and upload the contents of mailchimp-for-wp.zip to your plugins
directory, which usually is /wp-content/plugins/.
Activate the plugin.

e Configuring Sign-up Form(s)

Go to MailChimp for WP > Form

Select at least one MailChimp list to subscribe people to.

(Optional) Add more fields to your form using the add MailChimp field dropdown.
Embed a sign-up form in pages or posts by using the [mc4wp_form] shortcode.

Show a sign-up form in your widget areas using the “MailChimp Sign-Up Form” widget.
Show a sign-up form from your theme files by using the following PHP function.

<?php

if( function_exists( ‘mc4wp_show form’) ) {

mc4wp_show_form();

}

Wonder how to add Mailchimp Newsletter Sign-up Form to WordPress using WPBakery Page
Builder Addon? Click here to watch tutorial video!

3. To master Lightbox in 1 minute!

For better instruction, take a look at our tutorial video here!

e First, make sure to add "Lightbox" element into WPBakery Page Builder back-end editor
(located in KIT Addons tab)


https://codecanyon.net/item/marvelous-hover-effects-visual-composer-addons/19137816
http://cdn.ownego.com/products/wordpress/plugins/marvelous-hover/assets/Marvelous_Documentation.pdf
https://www.youtube.com/watch?v=MKy6DoVz0vQ
https://wordpress.org/plugins/mailchimp-for-wp/
https://www.youtube.com/watch?v=sC763C2xEgg&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F&index=13
https://www.youtube.com/watch?v=sC763C2xEgg&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F&index=13
https://www.youtube.com/watch?v=zYG6YZmgIuI&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F&index=12
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The "Lightbox Settings" panel will open > Set the Lightbox ID. You can type any name you want,
this ID helps a button (or anything can open a link) to identify which lightbox to open.

®  ClassicMode  Frontend Editor
Lightbox Settings
o o

WPBakery Page Builder
Genearal Design Options

it Lightbox 1d
— write any name
u ==k Semmemi ""y"' A2 H demo \
+ 2 %
b 20X
Lightbox size )
(=) + _ c
Medium v
+ Select the size box size
Width (px)

Click "+" to add any element inside lightbox. Or you can drag element into it.
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Done. You've successfully created a Lightbox.

e Next, let's create a button to open this lightbox!

By default, the "Button" element of VCKIit (located in KIT Addons tab) has a function to open a
Lightbox.

Let's add a VCKit's Button:

® Dashboard
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All Pages E Fade in, scale in, -

Before After

Button : Carousel
5 Card Fli
7"3":;5"1 : L

Count Down
# Comments Contactform7 | SR Dropcapsl
@ Contact
Heading

Heading Effects Gradient
S @
& Plugins (& : : :

g e e Image Swap Interactive mteratt_lve ;\rl\te_rract\yen

& Tools

Builder e

§ Settings E Progress Bar E Separator

# MailChimp for

Team member Tilt Hover : . Video Modal
- EE - @

Gradient T

- Mailchimp One Page
Lightbox List PPl Newsletter L e Navigator Ry Pricing Box
WPBakery Page Ut e [Q N (] e (] o L
@] -




In the "Button Settings", scroll down to the end and find "Advanced on click action" box, choose
"Open lightbox".

The "Lightbox ID" field will appear, type the chosen Lightbox ID. (as example above: "demo").

WPBakery Page Builder Button Settings

General Design Options

Extra class name +:
o = +
+ 2 X
o +20X Styl r content element differently - add o dass name and refer to
@ ° Video Player res
Viden fink tiipe;/ Ameocomy/5 1569652 Advanced on click action
+ Open lightbox v
a2
= = Lightbox ID
+ 2 X
demo
B rsmoe type the targeted
Lightbox ID e
L= 3 o

Done. Now when clicking on this button , it will open the Lightbox with ID "demo" (the one has a
video inside it).

e Here is a tip!

Beside VCKit's Button, you can make any other element to open VCKit's lightbox, as long as that
element has a function to "Open a Link".
Add an element which has option to open a link.

e Fillin the URL field: #lightboxid (remember to add # and remove http)

e Add extra class name: open-vckit-lightbox

e That's all steps to make this element open a Lightbox instead of a link.

For example:
Add a Single image > Set "On click action": "Open custom link" > Fill in the Image Link: #demo



WPBakery Page Builder

Single Image Settings

General Design Options

X =¥
+ 2 X
b +20X
e
+
= +
+ 2 X
. Single Image Add image
+

On click action

Open custom link v

Image link

#demo

Link Target

Same window v

CS5 Animation

Add an extra class name in this Single image element: open-vckit-lightbox

WPBakery Page Builder

el — |
b 2
52 +20X
B O/
+
+

e +

' Single Image Add image

And you are done!

4. Carousel Slider

Single Image Settings

General Design Options

Animate it

Element 1D

specification)

Extra class name

open-vckit-lightbox I

You can “Carousel anything” by using “Carousel” element.
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Click on “+” to add a Carousel Item.
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You can add an element to Carousel Item by clicking on “+” or drag an element into it.

WPBakery Page Builder A
% =R | B e RS
+ & X

& +20X

5z +20X
. Single Image Addimags

| am text block. Click edit button to change this text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec
ullamcorper mattis, pubvinar dapibus leo.

-+
e +20X
‘l .; 'jover Bf’:‘ Hover Box Element
-+
+
_I_

Each item should be added in a Carousel Item.

You can always edit settings of this Carousel by clicking on the pencil symbol to show the “Carousel
Settings”. In here, you can choose the number of item to show per row on each screen size.

WPBakery Page Builder Carousel Settings £_ x
Ll — | Enable vertical mode -
o S
52 a., Desktop Columns Tablet Columns Mobile Columns
N Count Count Count
b 20X

12 columns-1/1 v 12 columns-1/1 v 12 columns-1/1 v

cJ I Single |
i Add i
ingle Image Add image

| am text block. Click edit button to change this text. Lorem ipsumn dolor sit ame

ullamcorper mattis, pubvinar dapibus leo. Gap spacing
-+ 30px v
p¢ +20X Select gop between grid elements.
& 'jovf'3°x e Extra class name



5. Testimonial

Installing “Testimonials by WooThemes” can be done either by searching for “Testimonials by
WooThemes” via the Plugins > Add New screen in your WordPress dashboard, or by using the
following steps:

Download the plugin via WordPress.org.

Upload the ZIP file through the Plugins > Add New > Upload screen in your WordPress
dashboard.

Activate the plugin through the ‘Plugins’ menu in WordPress

Place <?php do_action( 'woothemes_testimonials'); 7> in your templates, or use the
provided widget or shortcode.

Please watch our tutorial video for better understanding.

6. lcon Box

This element is actually Elegant Icon Box, so you can watch tutorial video for more instruction.

7. Contact Form 7

Install Contact Form 7 first to use this addon.

All VCKit form templates can be found in your package downloaded from codecanyon. Extract the
downloaded package and extract file import.zip, then find a file named:
visualcomposerkit.wordpress.xml inside it.

8. Pricing Box

Please watch our tutorial video for better understanding.

9. Grids

Our plugin includes 5 kinds of grid, click on each name below to watch its own tutorial video:
Samsung Grid

Elegant Grid

Interactive Grid

Magazine Grid

Google Grid



https://wordpress.org/plugins/testimonials-by-woothemes/
https://wordpress.org/plugins/testimonials-by-woothemes/
https://wordpress.org/plugins/testimonials-by-woothemes/
https://www.youtube.com/watch?v=1Lza5VdX6C8&index=11&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F
https://codecanyon.net/item/elegant-icon-box-visual-composer-addon/19477372
https://www.youtube.com/watch?v=5v4BO6rx3Ws
https://wordpress.org/plugins/contact-form-7/
https://codecanyon.net/item/visual-composer-kit-vckit-addon-wordpress-plugin/19734408
https://www.youtube.com/watch?v=yDuO1SiCSOQ&index=14&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F
https://www.youtube.com/watch?v=PwWxT607gSs&index=5&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F
https://www.youtube.com/watch?v=aJ3xWg3nHFg&index=9&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F
https://www.youtube.com/watch?v=I3aIkDNLCTw&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F&index=7
https://www.youtube.com/watch?v=AP8DCu-dNZ0&index=6&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F
https://www.youtube.com/watch?v=-MM3WETJT6I&list=PLqO8BVTBpMDlrzQP4r6pOE7bu0vGhMZ9F&index=8

10. Gradient Background

It's a row background with gradient.
After adding “Gradient Background” element, the “Gradient Background settings” panel will appear.
(you can always open its panel by clicking on the pencil symbol).

Gradient Background Settings

* General Design Options
+
e
Type
— +
% Linear gradients v
+ 2 X
z e‘ px Color strip
m + C Al
Color

+ | Select Color |

Position g Select Color

There are 2 types of gradient: Linear or Radial.

Add your color gradient in Color strip, you can add as many colors as you want and set the
percentage of each color appearance.

You can also choose Direction of Linear, or choose Shape of Radial.

You can add an image background under the color gradient. (Note that the image is under
the color, so you need to lower the opacity of each color to see the image)

Gradient Background Settings

General Design Options

Color

- rgba(221,51,!| | Clear

:

G Esroes

Alpha: 67%

EJ\



e After setting the Gradient color, you can add anything you want inside this background

+ & X
ol LOX

= b

11. Row Background

After activating VCKit, a new tab named “Advanced Options” will show up in Row settings (click on
the pencil symbol to edit row).

PBakery Page Builder.

Row Settings

General  Design Options  [JEtalETala=te Roleidelyld

Sc Background position

Per Default o7

Content alignment

Yo Default v =
ent in a row.
Wi "
‘ = ' m
Select single bar background color.
: - 21 X
Overlay background color
Select Colar
Choaose an overlay color for background. Leave blank for none
Background type
None v

Save changes



V. PLUGIN OPTIONS

1. General

Hover to VC Addons KIT on the left panel of your dashboard.
There’re some general options to config here.

Pages
General Meodules Smooth Scroll About
Comments
Contact General settings
Appearance :
Gocolemapsapekay AlzaSyBip-8fRLCyiclqDgEPem4Si1r6ULnXtto

Plugins {4

here
Users

Override contact form 7

Tools
template

WPBakery Page
Interactive grid apply for? | Post

Settings Page
Attachment
.  MailChimp for WP Custom_css
W Customize_changeset
o oKL Ved_templates

General Mecdwp-form

Modules

ALt Enable lazyload image

2. Modules:

Enable/disable shortcodes.

Pages

General Modules Smooth Scroll About
Comments
Contact Control the modules you want to use with Addons KIT
Appearance Custom VC Row

Plugins {4

Animation Block
Users

Tools
S Before After Image

WPBakery Page

Button
Settings
Card Flip
MailChimp for WP
° VCKit Carousel

neral

Modules Carousel ltem

Smooth Scroll




3. Smooth Scroll:

Add smooth scroll function to your site

Comments

General Modules Smooth Scroll
Contact
Appearance Add smooth scroll to your website

Plugins (4

Enable Smooth scroll
Users

Tools Scroll speed

WPBakery Page

Settings

MailChimp for WP

Q vcit

4. About:

About

All information about System Requirements and Changelog are here.

Users System requirements
Tools Wordpress Version v 7.7
WPBakery Page Vizual Compaser Version w3.4.2
i Memory Limit 256M
Settings ¥ Upload Max, Filesize 160 84 (recommended)
M Max. Post Size 16M 64M (recommended)
MailChimp for WP PP version V5.416
VCKit
General Update history
Modules
Sl i 2.0.8 / 2017-11-08
About ==================
B Quick View * Fix: icon showcase color default

* Update: workflow stylesheet



V. STAY UPDATE & SUPPORT

Thank you for purchasing our passionate work.
We’re ceaselessly working hard to bring more features and better UX into each new version of
VCKit. So make sure that you have followed all the steps below to get update email from Envato:

- On Codecanyon go to your profile > Settings > Email settings > Check the box “ltem update
notifications”.

- Go to your Downloads page, check the box “Get notified by email if this item is updated” of
VCKit item.

That'’s all. Everytime we update a version, Envato will automatically send an email notification to
you.

e Support:
If you have any question, please do not hesitate to use our support center:
https://support.themelego.com
Or send us a private email to support@themelego.com
We are happy to help!

*kkkk

Additionally, if you like VCKit, please rate it on the same Downloads page. We really wish to hear
your feedback about our product.

It means a lot to us and gives us enormous motivation to deliver other great work to you.

Thank you and enjoy now!


https://codecanyon.net/downloads
https://support.themelego.com/
mailto:support@themelego.com
https://codecanyon.net/downloads

